Milestone Systems

XProtect® Advanced VMS 2014

Administrator's Manual

m

The Open Platform Company




Milestone XProtect® Advanced Administrator's Manual
VMS 2014

Contents
COPYRIGHT, TRADEMARKS AND DISCLAIMER ... 11
BEFORE YOU ST AR T oottt e 12
INTRODUCTION TO THE HELP .+t ttititiiie et ee et et e e e e e e e s ee e s s e e e e e ene s e e e sns e e eneanes 12
NAVIGATE THE BUILT=IN HELP SYSTEM . tutuiuittnineseenenserenenrerensnserensnssrensnssrenenesres 12
SYSTEM OVERVIEW ..ottt eaees 14
P RODUCT OVERVIEW .. nttiteettt ettt ettt ee st e st eaee s e eneeseneaseseneaeasen e seren e eerenenenen 14
A DISTRIBUTED SYSTEM SETUP .iuitiinititiiitetsetaessetaeseestssssstssssstsnssseaenssrearnssres 15
SYSTEM COMPONENTS . euttttt ettt eee et ens e e e ea et s et earea et eata s er e renrenees 15
Y ETa = To L=t 0 g =T oA =T YA T TP PTPTTR PSPPI 15
Failover Management SEIVEL ......ouuii ittt et st e e 16
RECOIAING SEIVEI i, 16
Failover reCording SEIVEN ..o, 16
V2 £ LAY =T V=T 17
(I o Yo ST =] 0= TP 17
ST Y =T V= PPN 17
ACTIVE DIFECTOTY ..ttt s 18
A AR U= Y= AVA=] £ 18
(@A 11T 01 £ 18
F AN =0 1 o = ] = 21
PRODUCT COMPARISON CHART ..uititittetiete it ee et et e et e eas e e e st st s eas e s eneteenerneanss 22
ABOUT LOCAL IP ADDRESS RANGES ..uttiuitititinittestnesteeeestereaesssseaeneeseaessreaeeeres 23
ABOUT IPVB AND IPVA ... et eas 23
About using the system With TPV ... 23
ADOUL WIItING TPV A0UIESSES ..coiiiiiititeiie ettt e e e 24

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

SYSTEM REQUIREMENTS ettt eetttteeseetesseseesesseseesesseseesessaseesessaseeresnnreeresnaarees 25
INSTALLATION . .. e e e e e 26
INSTALLATION PRECONDITIONS ...uittiitieeiiieiieeei e et eeen e e e e eae e e ee e eeaneeaneesneenneeanes 26
Determine installation Method...........ooiiii e 26
Determing SQL SEIVEI LY P .uuuiiiiiiie e i ittt e e e e st ettt e e e e e s e st er e e e e e s e s assbaaaeeeeeesaasnraneeaaeeeas 26
SElECt SEIVICE ACCOUNT ...tiiiiiiiiiee ettt e st e e e st e e e e abee e e e sbreeeeanes 27

y o (VAT =T o3 o ] Y PR 27
CUSEOMIZE IS ..ttt et e e st e e e st b e e e e s abb e e e e sbreeeeanes 28
ADOUL VIFUS SCANMNMING ..uuiiiiiiiiiii s 28
Register Software License COde ......ooooveeeiiii i, 29
Prerequisites for offline installation ..., 30
INSTALL THE SYSTEM 1.ittiitiiii it eeie e et e e e et e e e e e e e e et e e e e e e e ea e st e e e e e aneeeaneeanes 30
Install your system - Single Server OPtion ... 30
Install your system - Distributed option ............c.c 31
Install your system - CUSTOM OPLION c...ueiiiiiiiiie e 32
Install the recording SErVer ... 33
INStallation fOr WOFKGIOUPS .uuuieiiiii ettt e e e e e e e s s e e e e e e s e nnnnaeeeaaeeean 34
Installation troubleshOooting ... 34
CONFIGURE THE SYSTEM IN MANAGEMENT CLIENT .ectuuiiiiiiiieeeeeeiie e eeeii e e eeein e 37
Change Software License Code ... 39
TS I B o I 11 P 39
Install XProtect Smart Client silently .........cccco 39
Install MilesStone MODIlI@ SEIVEL .......iii e 40
DOWNLOAD MANAGER/DOWNLOAD WEB PAGE ......uuuuuuutueerrrnennnnnnnnnnnnnnnnnnnnnnnnnnnnes 40
Download Manager's default configuration ..........cccoocoeiiiiii e, 42
Download Manager's standard inStallers (USEr) ...t 43
Add/publish Download Manager installer compoNents .......ccccccevvvciviiiiiee e 43
Hide/remove Download Manager installer COmponents ........coocceeeiiiieeiniiee e 44
Device pack installer - must be downloaded ...........ccccooiiiiiiiiiiiiii e 45

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

=TT 2 o ] =P 45
WY oo UL VT o o] - To L= SR 45

U] To 1= (o L=l o] =T = To [ U EoY L (=TSP 46
Alternative upgrade fOr WOTKGIOUP «...ueiii ittt 46
FIRST TIME USE ... 48
B EST PRACTICES .. ttuitttieit et et e et e et e e et e et e e e e et e e e n e e e e e e e e e e eaneeaeeanes 48
Protect recording databases from COrrUPtioN ......cccceeeiiiiiiiiieec e 48
About daylight SAVING tIME ..o e 49
ADOUL TIMEB SEIVEIS ..t e e e et e e e e e e e s b ab e eeaaeeeas 49
MANAGEMENT CLIENT OVERVIEW .11vuiititniitiiteetietietneetsetesneesissesnsesesneenissneens 50
About [0giN AUENOTIZALION ......uei s 50
Management Client WindOW OVEIVIEW .........uuiiiiiiiie ittt 50
PANES OVEIVIEW ...ttt e e e e e st e e e e e e e e sttt e e e e e e s e ansnbaeeeaaeeesaasntaneeaaeenas 52
IMIENIU OV EBIVIBW ...ttt ettt e e e e ettt et e e e e e sk bbb et e e e e e s e e abbbb e et e e e e e s annnnbaneeeaeeeas 53
MANAGEMENT CLIENT ELEMENTS......ccoi e, 56
N [ 56
LiCeNSe INFOIMALION ..oeiiiie e e e e e st e e e e e e s e raeeeaeeeeas 56
SITE INFOIMALION Lottt e e et r e e e e e e e s aebeeee s 60
SERVERS AND HARDWARE .....cuuiitt ettt e et e eetaeeet e e e et e e eaa e e eaa s e eannaeeaneeeanaeenannns 61
RECOIAING SEIVEIS oo, 61
Hardware and remMOTE SEIVEIS .....oiiii it iiiieiie e e e ettt e e e e e s s steetr e e e e e s s annb e e e e e e s aannnaeeeaaeeeas 78
REMOVE @ reCOrdiNg SEIVEI ..o, 86
Delete all hardware on a recording SEIrVEr .....ccoeeieiiiiiie e, 87
DBV CES i 87
WOrking With deVICE grOUPS ..cooiiueiiiiiiiiie ettt et 87
WOTKING WIth QEVICES.....ciiiiiiiiiiii e 90

O 1= N P 133
ADOUL CHIBNES ..t 133

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

RV o 1 o 101 1= U 133
SMart ClIeNt ProfileS ... e e e s e 134
Management ClIent Profiles ... 138
Y =LA 3 PRSP PPU RPN 141
RULES AND EVENTS ... iittiiiiiiiiii e e eei e e e s e s ee s e s e e s e e s e nne e e enees 143
ADOUL TUIES AN BVENTS ..uuiiiiiiii e nnnnnnannnns 143
About actions and STOP ACHIONS ....iiiiiiiiie ittt 144
EVENES OVEIVIEW ...ttt ettt e et e e s e e e s n e e e s anneee e e 152
RUIES ettt e et e e e st e e e e st b e e e e aabb e e e e et be e e e abreeeeane 159
TIME PrOTIHES oo s 167
Notification pProfiles......oi 171
USEr-0efiN@0 EVENTS ...ttt e et e et e e e e sbaeeeeanes 175
ANAIYLICS BVENTS ..o s 177
(T LT g ol V2= o) £ S S PSP PUPPOPPP 180
Y =110 i 12 187
0] 1= TP PUPP PP TPPPRPOt 187
BASIC USEIS ..ttt ettt e et e et e s e et e e e e e e e e e e 220
SYSTEM DASHBOARD .....eeiiitiititiiia e e e e eeeesssas e e e e e e e e eeesa e e e e e e e e e e e nnnna e e eeee s 221
About system dashbOard ... 221
ADOUL SYSEEM MONITOT .eeiiiiiiiiie ittt e e 221
ADOUL VIAENCE TOCK ..o 223
ADOUL CUITENT TASKS .ttt et e e e 223
ADbOUL CONFIGUIAtION FEPOTTS .ooiiiiiiie it 223
SERVER LOGS ..iiitttttiiiieeeeeetittiti e e e ettt s e e e e e et e e e e e e e e e e n b e e e e 224
ADOUL [OGS .ttt s 224
Y=z T (o] o o To -3 OO PPP PP 225
[ S0q o 1o Y A Fo To - SO RPPPPRPE 225
Change [0g [aNQUAGE ......ciiiei ettt e e et e e e e e e e enbeeeeeas 226
SYSLEM [0Q (PrOPEITIES) c.ueeiiiiiiiiie ettt st e e e e e e s naneeee s 226
LU Lo [ Koo I { ] o] e 1=] 4 AL=2S) F PP EUT U 227

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

U L= (o Yo T (o] o] o= A T=E) ISR 228
I 2 P 229
About alarm CONFIGQUIALION .....ceiiii i e e e e e e e e 229
ADOUL BIAIMNIS ittt e et e e e e s b e e 230
ALArM DEfINITIONS .eeeii e e e 231

F T D=\ = ST T o £ PR 233
SOUNGA SEELINGS -eeeeeeiitiiiee ittt et e ettt e e e s bbbt e e s abb e e e s anbb e e e s aanreee s 234
About setting up alarms using Enterprise slaves .......cccccooooiiiiiiiiiiiiiiiccccceceeccece e 234
OPTIONS DIALOG BOX ...eeeeitieeiniiiineaeeeeeeesssasis s e e e eeseeesssnns e e e e e e e eesnnnnn s e eeees 235
General tab (OPLIONS) coov i 236
Server LOgs tab (OPTIONS) ...ii ittt 238
Mail Server tab (OPLiONS) coovoi e 239
AVI Generation tab (OPLIONS) ..ooiveiiiiiiiiee e 240
NetwOork tab (OPTIONS) .t 241
Bookmark tab (OptionNS) ..o 241
Evidence LOCK tab (OPLIONS) ...eiiiiiiiiiiiiiiee ettt 242
User Settings tab (OPtioNS) ..o 242
Access Control Settings tab (OPLioNS) .....cueviiiiiiiii 242
Analytics Events tab (OPtioNS) ... .. 243
Event Server tab (OptionsS) ..o 244
Generic EVents tab (OPLiONS) ..ueii i 244
FEATURE CONFIGURATION .....ciiii e 247
FAILOVER RECORDING SERVERS (REGULAR AND HOT STANDBY) ....ccvveeereiinnrnnnnn 247
About failoVer reCOrdiNg SEIVEIS ... ... s 247
ADOUL FAIIOVET STEPS ..ttt et 248
About failover recording server funNCtionNality ... 249
Install a failover reCOrding SEIVEI .. ... i 250
Set up and enable failover recording SErvers ..o 251
ASSIgN failloOVEr reCOTdiNG SEIVEIS .....uiiiiiiie ettt a e e e e e 251
Group failloVer reCOIdiNG SEIVEIS ...ttt 252

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

Read failover recording server StatUS iCONS ......cccvvvivieeeii i 252
Failover recording SErver PropPerties ... iiiiiiiieee e e st e e e e e e e e e e e e s e nnranee e 253
FailOVEr groUP PrOPEITIES ..o iiiiii ittt e et e e et e e e e snneeeeanes 253
About failover recording SEIVEIr SEIVICES .....cccuviiiieie e iiiciieie e s e e e eea e e 254
VIEW STALUS MESSAGES ..eeieiiiiiieiiiiiiee ettt e e ettt e ettt e e e sttt e e s sa bt e e s aabe e e e e anbe e e e e anbe e e e e anbeeeeennns 254
Change the management Server adareSS. ... iiiiiieeeee i e 254
View Version iNfOrMAation ... 254
FAILOVER MANAGEMENT SERVERS ......uiiiiitiiiiientieeeeeenineeeeenseeeennn e e eennnnaeeens 255
About multiple management servers (CIUStEring) ...cccoeevviiieeiiiiieeere e 255
Prerequisites for CIUSIEIING ..o 255
INSTAII TN @ CIUSTEI ..eiiii ettt e e e e e e e e 255
UPQGrade iN @ CIUSTEI ..o ettt e et e et r e e e e sbbeeeeanes 257
REMOTE CONNECT SERVICES.....uuiiuiiiitieiteeteeeieeetee et e et eesteeaneeaneesnneeaneesnaasnnaes 258
ADOUL remMOtE CONNECT SEIVICES .ueiiiiiiiiiie ittt 258
Install STS environment for One-click camera CoONNEeCtion .........cccovcvveeeiriieeeniineeeennns 258
AQA/EUIT ST SS ittt ettt e et e e et et e e e aa b bt e e s anbre e e e nnens 259
Register new Axis One-click camera .......ccccceeeiiiii 259
AXis One-Click Camera connection ProPertieS ... eiriieeeiiiiee e 260
MILESTONE FEDERATED ARCHITECTURE .....cccitiiiiiiiiiiniieeeeeeeerniis e e e e eeennnnis 260
About selecting Milestone Interconnect or Milestone Federated Architecture......... 260
About Milestone Federated ArChit@CtUIe.........ocviiiiiiii i 261
Set up your system to run federated SIiteS .......cooviiiiiiiiie it 264
Add SItE t0 NEIAIrCRY ..o s 265
Acceptinclusion in the NIErarChy ... ... 266
Refresh Site NErarChy.......ooo e 266
Connect to another site in hierarChy ... 266
Detach a site from the hierarChy ... 267
Federated Site PrOPEITIES ... it e e e e e e eas 267
MILESTONE INTERCONNECT ....ceiiiiiittiiiiiss e e e e eeeessnsis s s e e e e e eeesnnai e e e s e eeeannna s 269
About selecting Milestone Interconnect or Milestone Federated Architecture......... 269

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

ADbOUt MIleStONE INTEICONNECT.....cciiiiiiiiii e 269
About possible Milestone INterconNNEct SELUPS ..ovvvveeeiiiiiiieiieie e 271
Milestone Interconnect and lHCENSING ....oooiiiiiiiiiiiiie e 272
Update remote Sit€ NAardWarE ........ceccii i e e e e e e e s e snranee s 272
Establish remote desktop connection to remote SYStem ........occccevviiieeiiiieeeeiiieeeenns 272
Enable playback directly from remote site camera ...........ccccvveveeeeeiiicciiiieeee e, 272
Retrieve remote recordings from remote Site Camera .......cccccovvveeeiiiiieeeeiiieee e 273
XPROTECT SMART WALL .ttt ettt e e e e e e e eennnes 273
About XProtect Smart Wall ..o 273
Configure Smart WallS.........coooiiiii 274
Manage roles with Smart Walls ... 275
About using rules with Smart Wall PreSets ..o 276
Smart Wall Properties ... 276
Y T aTiNo ] g oY foT o1= ¢ A L= SO PO PUPPPPPPPPPNt 277
XPROTECT ACCESS CONTROL MODULE .....cccuiiiiiiieei e eee e e e e e 279
About access CONtrol INTEGIatioN ......c..ceoiiiiiieiie e 279
Configure an integrated access control system .......cccccciiiii 280
Wizard for access control system integration .........cccooeceiiiiiiee e 280
ACCESS CONEIOI PrOPEITIES ..uuiiiiii s 282
XPROTECT LPR .. 286
LPR SYSIEM OVEIVIEW ..o, 286
About preparing cameras for LPR ........ooo ittt 289
LPR INSTAIALION ..ttt e et e s abeeeeanes 302
LPR configuration ... 303
LPR MAINTENEANCE ....eiiiiiiiiie ittt e et e e e ebb e e e aba e e e e abbeeeeanes 322
MULTI-DOMAIN WITH ONE=WAY TRUST ....cuutiiriiiiiiiiiiiiiiiiiiiirsiissiesissssssssesssesses 325
SetUP WIth ONE-WAY TrUST....coiiiiiiiiiiiie e eneeee s 325
SN P L 326
ADOUL SNIMP SUPPOIT .ttt ettt e st e e e et e e e e 326

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

INSTAII SNMP SEIVICE ..itiiii ittt sttt e e e st e e e sttt e e e snbaeeeeabeeeeeane 326
CoNfIGUIre SNIMP SEIVICE .oiiii ittt a e e st r e e e e s e s nnrareees 326
XPROTECT ENTERPRISE SERVERS .....uuiiitiiitiieiiieeeiaeeeteeeei e eei e eai e eanaeennnns 327
ADOUL XProteCt ENTErPriSE SEIVEIS ...uuiiiiiiiiieeiiiite ettt 327
Add XProteCt ENTEIPriSE SEIVEIS ..ciiiiiiiieiiiiie ettt ettt e e 327
Define roles with access to XProtect ENterprise SErvers ....ooooccvevicivieeeeeeevesscvvnneens 328
Edit XProteCt ENtErPriSE SEIVEIS ....eiiiiiiieii ittt ettt ettt e et e e nneeeeaaes 328
SYSTEM MAINTENANCE ... 329
PORTS USED BY THE SYSTEM tuituiiuiitiitiitiiieetietiesneetietiesneesesesneeseseeeenesneen 329
BACKING UP AND RESTORING SYSTEM CONFIGURATION ...cuiviiinceiiinieieenieieeneenns 332
About backing up and restoring your system configuration ............ccccccoevviiiiiennennnn. 332
Back up log server database ... 332
Manual backup and restore of system configuration...........cccoocvveeiiiiiei e 332
Scheduled backup and resStore. ... 334
MOVING THE MANAGEMENT SERVER ....tuittittiitiitiiteitieiesieenstesnseteseensesesneenns 337
About moving the ManagemMENt SEIVET ..........uu s 337
About unavailable management SEIVErS ...t 338
Move the system CONfIQUIAtION .....cooiiiiiiiiii e 338
MANAGING THE SQL SERVER .. .uuiitiiiiiieiteee i eeiee et e e e e e e et e e e e e e e e e e ena s 338
About updating the SQL Server address ... s 338
Update the log server's SQL address .....cccoeveiiiiiiiii i, 339
Update the management server or event server SQL server address ........ccceeeeeene 339
REPLACE HARDWARE .......iititttitetetti e e e eet e e et eet e e e e eet e e e e eea s e e e eean s eeeesnnaeeeees 340
REPLACE A RECORDING SERVER ...ccuuiiitieitiniaitieeetiaeeeieeeeiseeeaseeeneeeaneeenneees 343
VIDEO DEVICE DRIVERS ....iitiiititiieett e etie e et e ettt e e et e e et e e et e e et e e et eeean e eean s 344
ADOUL VIAEO EVICE AIIVEIS ..ottt e e e e e e e 344
About remoVving Video deVICe ArIVEIS ....coocuiiiiiiiiiie ettt 344
SERVICES ...ttt ettt ettt e ettt e e ettt e e e et et e e e e e e e e e et e e e e e e e ra e e e nen e e e eranns 344

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

About the Management Server service and Recording Server service.........cccccee...... 344
VIEW STALUS MESSAGES ....oicuvveiiiiieeeieiiiieiie et e e e s e st e e e ee e e s s st ebaaeeeeeeesastataeeeeaeeesannrnteeeeaaeans 345
Read server service icons - management, recording and failover ...........cccccceoeeens 345
Change recording SErver SEHINGS ..oocoii i e e e e e e e e s enaaeee e 346
RecOrding SEIrVer PrOPEeItiES ....ccoiiiiiiiiiiiee ettt ettt e et e e sbneeeeaaes 347
REGISTERED SERVICES .. ctuiiitiiiiieiieei e e e et e et e e e et e e e e st e et e eaneeeneeaneeanaaennns 348
AboUt the Service ChanNel ... 348
Add and edit regiStered SEIVICES ... ... 348
Manage network CONFIQUIAtION . .....eiiiiiiiee e 349
Registered Services PropPertieS. ... 349
IN D E X e 351

www.milestonesys.com Contents



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

Copyright, trademarks and disclaimer

Copyright € 2015 Milestone Systems A/S.
Trademarks
XProtect is a registered trademark of Milestone Systems A/S.

Microsoft and Windows are registered trademarks of Microsoft Corporation. App Store is a service
mark of Apple Inc. Android is a trademark of Google Inc.

All other trademarks mentioned in this document are trademarks of their respective owners.
Disclaimer

This text is intended for general information purposes only, and due care has been taken in its
preparation.

Any risk arising from the use of this information rests with the recipient, and nothing herein should be
construed as constituting any kind of warranty.

Milestone Systems A/S reserve the right to make adjustments without prior notification.

All names of people and organizations used in the examples in this text are fictitious. Any resemblance
to any actual organization or person, living or dead, is purely coincidental and unintended.

This product may make use of third party software for which specific terms and conditions may apply.
When that is the case, you can find more information in the file
3rd_party_software_terms_and_conditions.txt located in your Milestone surveillance system
installation folder.
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Before you start

Introduction to the help

The help is divided into sections that each serves a targeted purpose. The sections are structured in a
logical flow:

System overview (on page 14)

Provides an introduction to your video surveillance system, system components, and concepts. This is
useful if you are new to the system. The system overview also provides a comparison chart that lists
the most significant differences between the products.

Installation (on page 26)
Provides installation preconditions and step by step procedures that help you install and upgrade your
system.

First time use (on page 48)
Provides an overview of the Management Client and information about best practices to follow to have
your system running smoothly. This overview is useful if you are new to the system.

Management Client elements (on page 56)

Provides a thorough walk through of each of the nodes in the Site Navigation pane of the
Management Client. This section contains conceptual and procedural information about the basic
elements of your system.

Feature configuration (on page 247)
Provides self-contained, detailed information about the additional features and add-on products that
your system supports.

System maintenance (on page 329)

Provides an overview of the ports used in the system and step-by-step procedures for, for example,
backing up your system and monitoring system performance. This section is useful after installation
and configuration in order to maintain, expand and optimize your system.

Navigate the built-in help system

Press F1 to access a related help topic or select Help > Contents from the Management Client
toolbar to launch the complete help.

You can navigate between the help window's three tabs: Contents, Index, and Search or use the
links inside the help topics.

www.milestonesys.com 12 Before you start
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Contents

Index

Search

Administrator's Manual

Navigate the help system based on a tree structure.

Select the first letter of the term you are interested in and scroll until
you find it. Click a help topic title in the search results list to open
the required topic.

Search for help topics that contain particular terms of interest. For
example, search for the term zoom and receive a list in the search
result of all help topics that contains the term zoom. Click a help
topic title in the search results list to open the required topic.

To print a help topic, navigate to the required topic and click the browser's Print button.

www.milestonesys.com
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System overview

Product overview

This XProtect system is a fully distributed solution, designed for large multi-site and multiple server
installations requiring 24/7 surveillance, with support for devices from different vendors. The solution
offers centralized management of all devices, servers, and users, and empowers an extremely flexible
rule system driven by schedules and events.

Your system consists of the following main elements:

1 The management server - the center of your installation, consists of multiple servers
One or more recording servers
One or more XProtect Management Clients

The XProtect Download Manager

= = =4 =4

One or more XProtect® Smart Clients.

One or more XProtect Web Clients and/or Milestone Mobile clients if needed

Your system also includes fully integrated Matrix functionality for distributed viewing of video from any
camera on your surveillance system to any computer with XProtect Smart Client installed.

You can install your XProtect system on virtualized servers or on multiple physical servers in a
distributed setup.

The system also offers the possibility of including the standalone XProtect® Smart Client i Player
when you export video evidence from the XProtect Smart Client. XProtect Smart Client i Player allows
recipients of video evidence (such as police officers, internal or external investigators, etc.) to browse
and play back the exported recordings without having to install any software on their computers.

Your system can handle an unlimited number of cameras, servers, and users and across multiple sites
if required. Your system can handle IPv4 as well as IPv6.

www.milestonesys.com 14 System overview
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A distributed system setup

Example of a system setup. The number of cameras, recording servers, and connected clients, can be as high as you require.
Legend:
1. Management Client(s)
Event server
Microsoft cluster
Management server
Failover management server
SQL server
Failover recording server

Recording server(s)

© ® N o 0 M 0D

XProtect Smart Client(s)

.
©

IP video cameras
11. Video server

12. Analog cameras
13. PTZIP camera
14. Camera network

15. Server network

System components

Management server

The management server stores the configuration of the surveillance system in a relational database,

either on the management server computer itself or on a separate SQL Server on the network. It also
handles user authentication, user rights, the rule system and more. To improve system performance,
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you can run several management servers as a Milestone Federated Ar chi tectur eE.
server runs as a service, and is typically installed on a dedicated server.

Users connect to the management server for initial authentication, then transparently to the recording
servers for access to for video recordings, etc.

Failover management server

Failover support on the management server is achieved by installing the management server in a
Microsoft Windows Cluster. The cluster will then ensure that another server take over the
management server function should the first server fail.

Recording server

The recording server is responsible for communicating with the network cameras and video encoders,
recording the retrieved audio and video as well as providing client access to both live and recorded
audio and video.

Furthermore, the recording server is responsible for communicating with other Milestone products
connected via the Milestone Interconnect technology.

Device Drivers

1 Communication with the network cameras and video encoders are done through a device
driver developed specifically for individual devices or a series of similar devices from the same
manufacture.

1 The device drivers are by default installed when the recording server is installed, but can later
be updated by downloading and installing a newer version of the device pack.

Media Database

1 The retrieved audio and video data is stored in the tailor-made high performance media
database optimized for recording and storing audio and video data.

1 The media database supports various unique features like; multistage archiving, video
grooming, encryption and adding a digital signature to the recordings.

Failover recording server

The failover recording server is responsible for taking over the recording task should a recording
server fail.

The failover recording server can operator in two modes:
9 Standard failover i for monitoring multiple recording servers

1 Hot-standby i for monitoring a single recording server

The difference between the standard and hot-standby failover modes is that in the standard failover
mode the failover recording server does not know which server to take over from, so it cannot start
until a recording server fails. In the hot-standby mode the failover time is significantly shorter, as the
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failover recording server already knows which recording server it should take over from and can
preload the configuration and start up completely - except for the last step of connecting to the
cameras.

Event server
The event server handles various tasks related to events, alarms, maps and 3rd party integrations via
the MIP Software Development Kit (SDK).

Events:

1 All system events are consolidated in the event server so there are one place and interface for
partners to make integrations that utilize system events.

1 Furthermore, the event server offers 3rd party access to sending events to the system via the
Generic events or Analytics events interface.

Alarms:

1 The event server hosts the alarm feature, alarm logic, alarm state as well as handling the
alarm database. The alarm database is stored in the same SQL server the management
server uses.

Maps:

1 The event server also hosts the maps that are configured and used in XProtect Smart Client.
MIP SDK:

1 Finally third-party-developed plug-ins can be installed on the event server and utilize access to
system events.

Log server

The log server is responsible for storing all log messages for the entire system. The log server uses
the same SQL server as the management server and is typically installed on the same server as the
management server, but can be installed on a separate server if needed to increase performance of
the management and log servers.

SQL server
The management server, event server and log server uses an SQL server to store, for example, the
configuration, alarms, events and log messaged.

The system installer includes Microsoft SQL Server 2008 R2 Express that can be used freely for
systems up to 300 cameras.

For larger systems over 300 cameras it is recommended to use the SQL Server 2008 R2 Standard or
Enterprise edition on a dedicated server as these editions can handle larger databases and offer
backup functionality.
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Active Directory

You normally add users from Active Directory, but you can also add users without Active Directory.
Active Directory is a distributed directory service included with several Windows Server operating
systems. It identifies resources on a network in order for users or applications to access them.

Virtual servers

You can run all system components on virtualized Windows® servers, such as VMware® and Microsoft®
Hyper-Ve.

Virtualization is often preferred to better utilize hardware resources. Normally, virtual servers running
on the hardware host server do not load the virtual server to a great extent, and often not at the same
time. However, recording servers record all cameras and video streams. This puts high load on CPU,
memory, network, and storage system. So, when run on a virtual server, the normal gain of
virtualization disappears to a large extent, since - in many cases - it uses all available resources.

If run in a virtual environment, it is important that the hardware host has the same amount of physical
memory as allocated for the virtual servers and that the virtual server running the recording server is
allocated enough CPU and memory - which it is not by default. Typically, the recording server needs
2-4 GB depending on configuration. Another bottleneck is network adapter allocation and hard disk
performance. Consider allocating a physical network adapter on the host server of the virtual server
running the recording server. This makes it easier to ensure that the network adapter is not overloaded
with traffic to other virtual servers. If the network adapter is used for several virtual servers, the
network traffic might result in the recording server not retrieving and recording the configured amount
of images.

Clients

About the Management Client

Feature-rich administration client for configuration and day-to-day management of the system.
Available in several languages.

Typically installed on the surveillance system administrator's workstation or similar.

For a detailed overview of the Management Client, see Management Client overview (on page 50).
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About XProtect Smart Client

Designed for Milestone XProtect® IP video management software, the XProtect Smart Client is an
easy-to-use client application that provides intuitive control over security installations. Manage security
installations with XProtect Smart Client which gives users access to live and recorded video, instant
control of cameras and connected security devices, and an overview of recordings. Available in
multiple local languages, XProtect Smart Client has an adaptable user interface that can be optimized
for indivi dubkslandagustedatcarding i specifis skills and authority levels.

The interface allows you to tailor your viewing experience to specific working environments by
selecting a light or dark theme, depending on room lighting or brightness of the video. It also features
work-optimized tabs and an integrated video timeline for easy surveillance operation. Using the MIP
SDK, users can integrate various types of security and business systems and video analytics
applications, which you manage through XProtect Smart Client.

XProtect Smart Client must be installed on users' computers. Surveillance system administrators
manage clients' access to the surveillance system through the Management Application. Recordings
viewed by clients are provided by your XProtect system's Image Server service. The service runs in
the background on the surveillance system server. Separate hardware is not required.

To download XProtect Smart Client, you must connect to the surveillance system server which
presents you with a welcome page that lists available clients and language versions. System
administrators can use XProtect Download Manager to control what clients and language versions
should be available to users on the welcome page of the XProtect Download Manager.

About Milestone Mobile client

Milestone® Mobile client is a mobile surveillance solution closely integrated with the rest of your
XProtect system. It runs on your Android tablet or smartphone, your Apple® tablet, smartphone or
portable music player or your Windows Phone 8 tablet or smartphone and gives you access to
cameras, views and other functionality set up in the management clients.
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Use the Milestone Mobile client to view and play back live and recorded video from one or multiple
cameras, control pan-tilt-zoom (PTZ) cameras, trigger output and events and use the Video push
functionality to send video from your device to your XProtect system.

If you want to use Milestone Mobile client with your system, you must add a Mobile server to establish
the connection between the Milestone Mobile client and your system. Once the Mobile server is set
up, download the Milestone Mobile client for free from Google Play, App Store or Windows Phone
Store to start using Milestone Mobile.
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About XProtect Web Client

XProtect Web Client is a web-based client application for viewing, playing back and sharing video. It
provides instant access to the most commonly used surveillance functions, such as viewing live video,
play back recorded video, print and export evidence. Access to features depends on individual user
rights which are set up in the management client.

To enable access to the XProtect Web Client, you must install a Mobile server to establish the
connection between the XProtect Web Client and your system. The XProtect Web Client itself does
not require any installation itself and works with most Internet browsers. Once you have set up the
Mobile server, you can monitor your XProtect system anywhere from any computer or tablet with
Internet access (provided you know the right external/Internet address, user name and password).

About licenses

When you purchase the system, you also purchase a certain number of licenses for the number of
hardware devices, for example video encoders or cameras, that you want to run on the system. One
hardware device license enables you to run as many camera, speaker, microphone, input, output and
metadata devices that the hardware device consists of. It also enables you to run the hardware device
multiple times on one site or multiple times on multiple sites.

You need a camera license for each enabled interconnected camera in a Milestone Interconnect
setup.

If you purchase XProtect Access Control Module, you need a license for each door you want to
configure for access control.

At first, when you have installed the various system components, configured the system, and added
recording servers and cameras through the Management Client, the surveillance system runs on
temporary licenses which need to be activated before a certain period ends. This is known as the
grace period. You also need to activate licenses if you later add more cameras to the system.

When the new surveillance system is working, Milestone recommends that you activate your licenses
before you make the final adjustments. If you do not activate your licenses before the grace period
expires, all recording servers and cameras without activated licenses stop sending data to the
surveillance system.
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Product comparison chart

XProtect Advanced VMS comes in two versions:
1 XProtect Expert

1 XProtect Corporate

The complete feature list is available on the product overview page on the Milestone website
http://www.milestonesys.com/Software/XProtect-1P-Video-Surveillance/xprotectproducts/.

Below is a list of the differences between the two products:

Milestone Interconnect Remote site Central/remote site
Milestone Federated Architecture Remote site Central/remote site
Recording server failover and i n
hot stand-by recording server -
Remote connect services - n

XProtect Corporate XProtect Corporate database
Multi-stage video storage database Live databases + unlimited

Live databases + 1 archive  archives

Reduce frame rate (grooming) - n

Video data encryption (recording

server) i n

Database signing (recording server) - n

Time controlled user access rights - n

Bookmark function Manual only Manual and rule-based

Overall security Client user rights Client user rights/
administrator user rights

XProtect Management Client profiles - n

XProtect Smart Client profiles 3 Unlimited

XProtect Smart Wall optional n

Evidence lock - n
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About local IP address ranges

When a client, such as XProtect Smart Client, connects to a surveillance system, an amount of initial
data communication, including the exchange of contact addresses goes on in the background. This
happens automatically, and is transparent to users.

Clients may connect from the local network as well as from the Internet, and in each case the
surveillance system should be able to provide suitable addresses so the clients can get access to live
and recorded video from the recording servers:

1 When clients connect locally, the surveillance system should reply with local addresses and
port numbers.

1 When clients connect from the Internet, the surveillance system should reply with the recording
servers' public addresses, that is the address of the firewall or NAT (Network Address
Translation) router, and often also a different port number (which is then forwarded to
recording servers).

The surveillance system must therefore be able to determine whether a client belongs on a local IP
range or on the Internet. For this purpose, you can define a list of IP ranges which the surveillance
system should recognize as coming from a local network.

About IPv6 and IPv4

Your system supports IPv6 as well as IPv4. So does XProtect Smart Client.

IPV6 is the latest version of the Internet Protocol (IP). The Internet protocol determines the format and
use of IP addresses. IPv6 coexists with the still much more widely used IP version IPv4. IPv6 was
developed in order to solve the address exhaustion of IPv4. IPv6 addresses are 128 bit long, whereas
IPv4 addresses are only 32 bit long. IPv6 offers more than ten billion billion billion times as many
addresses as IPv4.

More and more organizations are implementing IPv6 on their networks. For example, all US federal
agency infrastructures are required to be IPv6 compliant. Examples and illustrations in this manual

reflect use of IPv4 because this is still the most widely used IP version. IPv6 works equally well with
the system.

About using the system with IPv6

The following conditions apply when using the system with IPv6:

Servers

Servers can often use IPv4 as well as IPv6. However, if just one server in your system (for example, a
management server, recording server or failover recording server) requires a particular IP version, all
other servers in your system must communicate using the same IP version.

Example: All of the servers in your system except one can use IPv4 as well as IPv6. The
exception is a server which is only capable of using IPv6. This means that all servers must
communicate with each other using IPv6.
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Devices

You can use devices (cameras, inputs, outputs, microphones, speakers) with a different IP version
than that being used for server communication provided your network equipment and the recording
servers also support the devices' IP version. See also the illustration below.

Clients

If your system uses IPv6, users should connect with the XProtect Smart Client. The XProtect Smart
Client supports IPv6 as well as IPv4.

If one or more servers in your system can only use IPv6, XProtect Smart Client users must use IPv6
for their communication with those servers. In this context, it is important to remember that XProtect
Smart Clients technically connect to a management server for initial authentication, and then to the
required recording servers for access to recordings.

However, the XProtect Smart Client users do not have to be on an IPv6 network themselves, provided
your network equipment supports communication between different IP versions, and they have
installed the IPv6 protocol on their computers. See also illustration. To install IPv6 on a client
computer, open a command prompt, type Ipv6 install, and press ENTER.

Example illustration

No Matrix Monitor compatibility

If using IPv6, you cannot use the Matrix Monitor application with your system. Matrix functionality in
XProtect Smart Client is not affected.

About writing IPv6 addresses

An IPv6 address is usually written as eight blocks of four hexadecimal digits, with each block
separated by a colon.

Example: 2001:0B80:0000:0000:0000:0F80:3FA8:18AB

You may shorten addresses by eliminating leading zeros in a block. Also note that some of the four-
digit blocks may consist of zeros only. If any number of such 0000 blocks are consecutive, you may
shorten addresses by replacing the 0000 blocks with two colons as long as there is only one such
double colon in the address.
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Example:
2001:0B80:0000:0000:0000:0F80:3FA8:18AB can be shortened to

2001:B80:0000:0000:0000:F80:3FA8:18AB if removing the leading zeros, or to
2001:0B80::0F80:3FA8:18AB if removing the 0000 blocks, or even to
2001:B80::F80:3FA8:18AB if removing the leading zeros as well as the 0000 blocks.

Using IPv6 Addresses in URLs

IPv6 addresses contain colons. Colons, however, are also used in other types of network addressing
syntax. For example, IPv4 uses a colon to separate IP address and port number when both are used
in a URL. IPv6 has inherited this principle. Therefore, to avoid confusion, square brackets are put
around IPv6 addresses when they are used in URLSs.

Example of a URL with an IPv6 address:
http://[2001:0B80:0000:0000:0000:0F80:3FA8:18AB], which may of course be shortened to,
for example, http://[2001:B80::F80:3FA8:18AB]

Example of a URL with an IPv6 address and a port number:
http://[2001:0B80:0000:0000:0000:0F80:3FA8:18AB]:1234, which may of course be shortened
to, for example, http://[2001:B80::F80:3FA8:18AB]:1234

For more information about IPv6, see, for example, www.iana.org http://www.iana.org/numbers/. IANA,
the Internet Assigned Numbers Authority, is the organization responsible for the global coordination of
IP addressing.

System requirements

Important: Your system no longer supports Microsoft® Windows® 2003 (however, you can still
run/access clients from computers with Windows 2003).

Important: Your system no longer supports Microsoft® Windows® 32-bit OS (however, you can still
run/access XProtect Web Client and XProtect Smart Client from computers with Windows 32-bit OS).

For information about the minimum system requirements to the various components of your system,
go to the Milestone website http://www.milestonesys.com/SystemRequirements.
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Installation

If you upgrade from a previous XProtect version, see About upgrade (on page 45).

Installation preconditions

Read the installation preconditions before you start the actual installation.

Determine installation method

As part of the installation wizard, you must decide which installation method to use. Your selection
depends on the organization needs, but has typically been determined when purchasing the system.

The options are:

1 Single Server: installs all management server components, recording server, and XProtect
Smart Client on the current computer. You only need to make a minimum of selections and all
components are preselected in the un-editable component list. The SQL server is not in the
list, but is also installed on the current computer.

9 Distributed: installs only the management server components on the current computer. This
means that the recording server and XProtect Smart Client are not visible in the un-editable
component list. You must install the recording server, XProtect Smart Client, and SQL server
on other computers.

1 Custom: allows you to select freely among all management server components, recording
server, and XProtect Smart Client to install on the current computer. By default, recording
server is unselected in the component list, but you can edit this. Depending on your selections
you must install the unselected components afterwards on other computers plus the SQL
server.

For easy user and group management, Milestone recommends that you have Microsoft Active
Directory® in place before you install your system. If you add the management server to the Active
Directory after installing, you must re-install the management server, and replace users with new users
defined in the Active Directory.

Determine SQL server type

Read the following information to determine which SQL server type is right for your organization:

The Microsoft SQL Server Express Edition is a "lightweight" version of a full SQL server. It is easy to
install and prepare for use, and is often sufficient for systems with less than 300 cameras.

If you plan to perform frequent/regular backups of your database, Milestone recommends to use an
existing SQL server on the network. You must have administrator rights on the SQL server.

For large installations (300 cameras or more), Milestone recommends using a full-scale existing SQL
server on a dedicated computer on the network.
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Milestone recommends that you install the database on a dedicated hard disk drive that is not used for
anything else but the database. Installing the database on its own drive prevents low disk
performance.

If you select Distributed or Custom as part of the installation wizard, you must decide what to do
regarding the SQL server.

If you do not have an SQL server installed, the options are:
1 Install SQL Server 2008 Express on this computer.

1 Use an existing SQL Server on the network: When you use a dedicated computer for the
SQL database on the network, the list of SQL servers that your account can access appears.

If you have an SQL server installed, the options are:
I Usethe installed Microsoft SQL Server Express database on this computer.

I Use an existing SQL Server on the network: When you use a dedicated computer for the
SQL database on the network, the list of SQL servers that your account can access appears.

You are also asked whether you want to create a new database, use an existing database, or
overwrite an existing database.

o Create new database: For a new installation.

o Use existing database: If you are installing the database as part of upgrading to a newer
version of the system, and you want to use your existing database.

Select service account

As part of the installation wizard, you are asked to specify an account to run the services on the
servers. The service always runs on that account when the server is running - no matter which
account is used to log in:

I This predefined account

In a domain environment, you can choose to use a predefined network service account.
1 This account

In a domain environment, you can select a user account from the domain.

In a workgroup environment, you must first set up an identical user account with access to the
network drives on all servers in the system and then select this as your service account. The
service only runs when this user is logged in.

Active Directory

If you want to add users through the Active Directory service, a server with Active Directory installed,
and acting as domain controller, must be available on your network.

If you do not install Active Directory, follow Installation for workgroups (on page 34) when you start the
installation.
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Customize lIS

If you install on Windows Server 2008, Milestone recommends that you customize the standard 1S
installation:

1. InWindows Start menu, select Control Panel, then select Programs and Features.

2. Inthe Programs and Features window, click Turn Windows features on or off. This
opens the Windows Features window (window name may be different depending on
which operating system you are installing the service channel on).

3. Inthe Windows Features window, expand Internet Information Services.

4. Expand and select Web Management Tools, then expand and select 1IS 6 Management
Compatibility, then select IIS Metabase and 1IS 6 configuration compatibility.

5. Expand and select World Wide Web Services, then expand and select Application
Development Features, then select the following:

1 .NET Extensibility
ASP
ASP.NET

ISAPI Extensions

=A =A =4 =4

ISAPI Filters.
6. Expand and select Security, then select Windows Authentication.

7. Click OK.

About virus scanning

As is the case with any other database software, if an antivirus program is installed on a computer
running XProtect® software, it is important that you exclude specific file types and locations, as well as
certain network traffic. Without implementing these exceptions, virus scanning uses a considerable
amount of system resources. On top of that, the scanning process can temporarily lock files which
likely results in a disruption in the recording process or even database corruption.

When you need to perform virus scanning, do not scan Recording Server directories containing
recording databases (by default c:\mediadatabase), as well as all folders under that location). Avoid
also to perform virus scanning on archive storage directories.

Create the following additional exclusions:
1 File types: .blk, .idx, .pic
1 C:\Program Files\Milestone or C:\Program Files (x86)\Milestone and all subdirectories.

1 Exclude network scanning on the following TCP ports:
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XProtect® Advanced VMS 80, 8080, 7563, 25, 21, 9993

system

XProtect® Mobile 8081
XProtect® Transact 9001
or

1 Exclude network scanning of the following processes:

XProtect Advanced VMS VideoOS.Recording.Service.exe, VideoOS.Server.Service.exe,
system VideoOS.Administration.exe

XProtect Mobile VideoOS.MobileServer.Service.exe

XProtect Transact VideoOS.Transact. TransactService.exe

Organizations may have strict guidelines regarding virus scanning, however it is important that the
above locations and files are excluded from virus scanning.

Register Software License Code

Before installing, you must have the name and location of the license file that you received from
Milestone.

The Software License Code (SLC) is printed on your order confirmation. Milestone recommends that
you register your SLC before installation.

1. Go to the Milestone website http://www.milestonesys.com.

2. Atthe bottom of the page, click Software Registration. Alternatively select the SOFTWARE
tab and then Register your software.

3. Log into the software registration system with your user name and password.

If you have not used the software registration system before, click the New to the system?
link for registering yourself as a user and then log in.

4. In the software registration system, click the Add SLC link.
5. Type your SLC. When asked whether you want to add the SLC to your account, click OK.

6. Once you have added your SLC, log out.
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Prerequisites for offline installation

If you install the system on a server that is offline, you need the following:
1 The MilestoneXProtectAdvVMSSysteminstaller.exe file.
1 The Milestone XProtect Advanced VMS license file.

 OS installation media.

Install the system

Select one of the installation options:
1 Install your system - Single Server option (on page 30)
1 Install your system - Distributed option (on page 31)

1 Install your system - Custom option (on page 32)

Install your system - Single Server option

1. |If you are installing a version downloaded from the Internet, run the
MilestoneXProtectAdvancedVMSSysteminstaller.exe file from the location where

you saved it.

Alternatively, insert the software DVD. If the dialog box does not open automatically, run the
Mil estoneXProtectAdvancedVMSSysteminstaller.exe file from the DVD.

2. The installation files unpack. Depending on your security settings, one or more Windows®
security warnings appear. Accept these and the unpacking continues.

3. When done, the Milestone XProtect Advanced VMS dialog box appears,

a) Selectthe Language to use during the installation (this is not the language your system
uses once installed, this is selected later). Click Continue.

b) InType the location of the license file, enter your license file from your XProtect
provider. Alternatively, use the browse function to locate it. The system verifies your
license file before you can continue. Click Continue.

¢) Read the Milestone End-user License Agreement. Select the | accept the terms in the
license agreement check box. Optionally, select the Sign me up for the Customer
Experience Improvement Program check box. Follow the on-screen Read more link for

further information on this.

4. Select Single Server. A list of components to install appears (you cannot edit this list). Click
Continue.

5. Select Files location for the program file. In Product language, select the language in which
your XProtect product should be installed. Click Install.

6. The software now installs. When done, you see a list of successfully installed components.
Click Close.
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Microsoft® 1IS is automatically installed during the process. Afterwards, you may be prompted
to restart your computer. Do so and after restart, depending on your security settings, one or
more Windows security warnings may appear. Accept these and the installation completes.

When done, your installation completes and you can continue with configuration, see
Configuration process (see "Configure the system in Management Client" on page 37).

Install your system - Distributed option

1.

a)

If you are installing a version downloaded from the Internet, run the
MilestoneXProtectAdvancedVMSSysteminstaller. exe file from the location where
you saved it.

Alternatively, insert the software DVD. If the dialog box does not open automatically, run the
MilestoneXProtectAdvancedVMSSysteminstaller.exe file from the DVD.

The installation files unpack. Depending on your security settings, one or more Windows®
security warnings appear. Accept these and the unpacking continues.

When done, the Milestone XProtect Advanced VMS dialog box appears,

Select the Language to use during the installation (this is not the language your system uses
once installed, this is selected later). Click Continue.

b) InType the location of the license file, enter your license file from your XProtect
provider. Alternatively, use the browse function to locate it. The system verifies your
license file before you can continue. Click Continue.

¢) Read the Milestone End-user License Agreement. Select the | accept the terms in the
license agreement check box. Optionally, select the Sign me up for the Customer
Experience Improvement Program check box. Follow the on-screen Read more link for
further information on this.

Select Distributed. A non-editable list of components to be installed appears. Click Continue.

Select the type of SQL server database you want. Also specify the name of the SQL server.
Click Continue.

Select either Create new database or Use existing database and name the database. If you
choose the latter, select to Keep or Overwrite existing data. Click Continue.

Select Files location for the program file. In Product language, select the language in which
your XProtect product should be installed. Click Install.

The software now installs. When done, you see a list of successfully installed components.
Click Close.

Microsoft® 1IS is automatically installed during the process. Afterwards, you may be prompted
to restart your computer. Do so and after restart, depending on your security settings, one or
more Windows security warnings may appear. Accept these and the installation completes.

Install the recording server on a separate computer, see Install the recording server (on page
33).
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Install your system - Custom option

Note that with this option you can select or clear all of the components to install, except the
management server. The management server is by default selected in the component list and is
always installed. If one is already installed, it is updated.

1.

a)

10.

11.

If you are installing a version downloaded from the Internet, run the
MilestoneXPro tectAdvancedVMSSystemlnstaller.exe file from the location where
you saved it.

Alternatively, insert the software DVD. If the dialog box does not open automatically, run the
MilestoneXProtectAdvancedVMSSysteminstaller.exe file from the DVD.

The installation files unpack. Depending on your security settings, one or more Windows®
security warnings appear. Accept these and the unpacking continues.

When done, the Milestone XProtect Advanced VMS dialog box appears,

Select the Language to use during the installation (this is not the language your system uses
once installed, this is selected later). Click Continue.

b) In Type the location of the license file, enter your license file from your XProtect
provider. Alternatively, use the browse function to locate it. The system verifies your
license file before you can continue. Click Continue.

¢) Read the Milestone End-user License Agreement. Select the | accept the terms in the
license agreement check box. Optionally, select the Sign me up for the Customer
Experience Improvement Program check box. Follow the on-screen Read more link for
further information on this.

Select Custom. A list of components to be installed appears. Apart from the management
server, all elements in the list are optional. The recording server is by default deselected, but
you can change this if needed. Click Continue.

Select the type of SQL server database you want. If relevant, also specify the name of the
SQL server. Click Continue.

Select either Create new database or Use existing database and name the database. If you
choose the latter, select to Keep or Overwrite existing data. Click Continue.

Select either This predefined account or This account to select the service account. If
needed, enter a password and confirm this. Click Continue.

If you have more than one available 1IS website, you can select any of these. However, if any
of your websites have HTTPS binding, select one of these. Click Continue.

Select Files location for the program file. In Product language, select the language in which
your XProtect product should be installed. Click Install.

The software now installs. When done, you see a list of successfully installed components.
Click Close.

Microsoft® 1IS is automatically installed during the process. Afterwards, you may be prompted
to restart your computer. Do so and after restart, depending on your security settings, one or
more Windows security warnings may appear. Accept these and the installation completes.

Depending on your selections, install the remaining servers on other computers:
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a) Go to the Management server's download web page from Windows' Start menu.

b) Select Programs > Milestone > Administrative Installation Page and copy the Internet
address.

c) Log into each of the computers to install:.
1 Log server.
1 Event server.

1 Management Client.

d) Open an Internet browser, paste the address of the Management server's download web
page into the address field and download the relevant installer.

e) Run the installer.

12. Install the recording server on a separate computer, see Install the recording server (on page

33).

Install the recording server

Once you have installed the management server, download the separate recording server installer
from the management server's web page.

See Install a failover recording server (on page 250) if you want to install a failover server.

1.

On the management server, go to the Management server's download web page from
Windows' Start menu.

Select Programs > Milestone > Administrative Installation Page and copy the Internet
address.

Log into the computer where you want to install the recording server.

Open an Internet browser, paste the address of the Management server's download web page
into the address field and select the Recording Server installer. Save the installer somewhere
appropriate and run it from here or run it directly from the web page.

Select the Language you want to use during the installation. Click Continue.
Select:

Typical: to install a recording server with default values, or

Custom: to install a recording server with custom values.

Specify the recording server settings:

o Name.

o Management server address.

o Path to save recordings, and click Continue.
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8. If you selected Custom:
a) Specify the number of recording servers you want to install on this computer. Click Continue.

b) Specify the service account. If needed, enter a password and confirm this. Click
Continue.

9. Select Files location for the program file. In Product language, select the language in which
to install your system. Click Install.

10. The software now installs. When done, you see a list of successfully installed components.
Click Close.

When you have installed the recording server, you can check its state from the Recording
Server service icon.

11. When done, your installation completes and you can continue with configuration, see
Configuration process (see "Configure the system in Management Client" on page 37).

Installation for workgroups

If you do not use a domain setup with an Active Directory server, but a workgroup setup, do the
following when you install:

1. Log into Windows using a common administrator account.

2. Depending on your needs, start the management or recording server installation and click
Custom.

3. Depending on what you selected in step 2, select to install the Management or Recording
Server service using a common administrator account.

4. Finish the installation.

5. Repeat steps 1-4 to install any other systems you want to connect. They must all be installed
using a common administrator account.

You cannot use this approach when upgrading workgroup installations, see instead Alternative
upgrade for workgroup (on page 46).

Installation troubleshooting

The following issues may occur during or upon installation of the management server or recording
servers. For each issue, one or more solutions are available.

Issue: Recording server startup fails due to port conflict

This issue can only appear if the Simple Mail Transfer Protocol (SMTP) service is running as it uses
port 25. If port 25 is already in use for, it may not be possible to start the Recording Server service. It
is important that port number 25 is available for the recording server's SMTP service.
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SMTP Service: Verification and solutions
To verify whether SMTP Service is installed:
1. From Windows' Start menu, select Control Panel.
2. Inthe Control Panel, double-click Add or Remove Programs.

3. Inthe left side of the Add or Remove Programs window, click Add/Remove Windows
Components.

4. Inthe Windows Components wizard, select Internet Information Services (11S), and click
Details.

5. Inthe Internet Information Services (I1S) window, verify whether the SMTP Service check
box is selected. If so, SMTP Service is installed.

If SMTP Service is installed, select one of the following solutions:
Solution 1: Disable SMTP Service, or set it to manual startup
This solution lets you start the recording server without having to stop the SMTP Service every time:
1. From Windows' Start menu, select Control Panel.
2. Inthe Control Panel, double-click Administrative Tools.
3. Inthe Administrative Tools window, double-click Services.
4. Inthe Services window, double-click Simple Mail Transfer Protocol (SMTP).
5

In the SMTP Properties window, click Stop, then set Startup type to either Manual or
Disabled.

When set to Manual, the SMTP Service can be started manually from the Services
window, or from a command prompt using the command net start SMTPSVC.

6. Click OK.
Solution 2: Remove SMTP service
Removing the SMTP Service may affect other applications using the SMTP Service.
1. From Windows' Start menu, select Control Panel.
2. Inthe Control Panel window, double-click Add or Remove Programs.

3. Inthe left side of the Add or Remove Programs window, click Add/Remove Windows
Components.

4. Inthe Windows Components wizard, select the Internet Information Services (IIS)
item, and click Details.

5. Inthe Internet Information Services (IIS) window, clear the SMTP Service check box.

6. Click OK, Next, and Finish.
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Issue: Automatic installation of IS failed

The Internet Information Services (IIS) is normally installed automatically. If the automatic installation
fails, you must install the IIS manually:

1. If automatic IIS installation fails, you see an error message asking you to install the IIS
manually. In the error message box, click Install IS Manually.

2. Select Server Manager from Windows' Start menu. In the left side of the Server Manager
window, select Roles, then the Roles Summary.

3. Now select Add Roles to start a wizard.
4. Inthe wizard, click Next, select Web Server (11S), and follow the wizard's steps.

5. When you reach the wizard's Select Role Services step, you see that some role services are
selected by default. However you should select some additional role services:

o Under Security, select Basic Authentication and Windows authentication.

o Under Management Tools, select IS Management Console, expand it, and select IIS 6
Metabase Compatibility, IIS 6 WMI Compatibility, IIS 6 Scripting Tools, and IIS 6
Management Console.

When ready, the relevant part of the Role services tree should look like this:

o 7
[] Basic Authentication

= [V] Windows Authentication
.ﬁ_ Select Role Services [_] Digest Authentication
u [] Chent Certificate Mapping Authentication
[ ] 115 Client CertFicate Mapping Authentication

::;::m :::.h: o (] URL Authorization

Web Serve {115) e [V] Request Filtering
BT L 1P and Domain Restrictions

Confemation [= & Performance

[v] Static Cortent Compression
[] pynamic Content Compression
= & Management Tools
[] 115 Management Console
[] 115 Management Scripts and Tools
|| Management Service
= [V] 115 6 Management Compatibilty
[V] 115 6 Metabase Compatibiity
[V] 115 6 WMI Compatibility
[V] 115 6 Scripting Tools
[] 115 6 Management Conscle -

TS0 O Sbabins © o ima

Progress

Ronls

< Previous II Nt > I

6. Complete the wizard by following the remaining steps.
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Issue: Changes to SQL server location prevents database access

This is an issue if the location of the SQL Server is changed, for example by changing the host name
of the computer running the SQL Server. The result of this issue is that the access to the database is
lost.

Solution: Use the update SQL address tool found at the tray icon.

Configure the system in Management Client

Here are the tasks typically involved in setting up the system.

Even if information is presented as a checklist, a completed checklist does not in itself guarantee that
the system matches the exact requirements of your organization. To make the system match the
needs of your organization, Milestone recommends that you monitor and adjust the system
continuously.

For example, it is a good idea to test and adjust the motion detection sensitivity settings of individual
cameras under different physical conditions (day/night, windy calm weather, and so on) once the
system is running. The setup of rules, which determines most of the actions performed by the system
(including when to record video), is another example of configuration which to a large extent depends
on your organization's needs.
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You have finished the initial installation of your system.

See Install the system (on page 30).

Change the trial SLC to a permanent SLC (if required).

See Change Software License Code (on page 39).

Log in to the Management Client.

Authorize use of your system's recording servers.

See Authorize a recording server (on page 62).

Verify that each recording server's storage settings meet your needs.

See About storage and archiving (on page 65).

Verify that each recording server's archiving settings meets your needs.

See Archive settings properties (on page 73).

Detect the hardware (cameras or video encoders) to add to each recording server.

See Add hardware (on page 78).

Configure each recording server's individual cameras.

See About camera devices (on page 91).

Enable storage and archiving for individual cameras or a group of cameras. This is done
from the individual cameras or from the device group.

See Attach a device or group of devices to a storage (on page 68).

Enable and configure devices.

O 0 (o0 oj0|jo| o g 8 -

See Working with devices (on page 90).

The behavior of the system is to a large extent determined by rules, such as when cameras
should record, when PTZ (pan-tilt-zoom) cameras should patrol, when notifications should
be sent.

O

Create rules.

See About rules and events (on page 143).

Add roles to the system.
See About roles (on page 187).

Add users and/or groups of users to each of the roles.

See Assign/remove users and groups to/from roles (on page 190).

Activate licenses.

D See Activate licenses (online) (see "Activate licenses online" on page 58) or Activate
licenses (offline) (see "Activate licenses offline" on page 59).
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Change Software License Code

If you run your installation on a trial Software License Code (SLC) during the first period, you can
change it into a permanent SLC without any un- or reinstallation actions.

Important: This must be done locally on the management server. You cannot do this from the
Management Client.

1. On the management server, go to the notification area of the taskbar.

" 4

© T 0@ .l
2. Right-click the Management Server icon and select Change License.

3. Click Import License.

4. Next, select the SLC license file saved for this purpose. When done, the selected license file
location is added just below the Import License button.

5. Click OK and you are now ready to register SLC. See Register Software License Code (on
page 29).

Install clients

Install XProtect Smart Client silently

You can deploy XProtect Smart Client or your surveil!/
such as Microsoft Systems Management Server (SMS). Such tools let you build up databases of

hardware and software on local networks. The databases can then, among other things, be used for

distributing and installing software applications, such as XProtect Smart Client, over local networks.

1. Locate the Smart Client installation program (.exe) file - MilestoneXProtectSmart Client.exe or
MilestoneXProtectSmart Client_x64.exe for 32-bit and 64-bit versions respectively. You find
the file in a subfolder under the folder httpdocs. The httpdocs folder is located under the
folder in which your Milestone surveillance software is installed.

The path is typically:
C:\Program Files\Milestone\XProtect Management Server\lIS\httpdocs\XProtect Smart
Client Installer\[version number] [bit-version]\All Languages\en-US

For example:
C:\Program Files\Milestone\XProtect Management Server\lIS\httpdocs\XProtect Smart
Client Installer\2014 (32-bit)\All Languages\en-US

2. Run a silent installation using one of the following two options:

a Run with default parameter settings:
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To run a silent installation using the default values for all parameters, start a command prompt
(cmd.exe) in the directory where the installation program is located and perform the following
command:

>MilestoneXProtectSmart Client.exe -i quiet

This performs a quiet installation of the XProtect Smart Client using default values for
parameters such as target directory and so on. To change the default settings, see below.

b Customize default parameters using an xml argument file as input:

To customize the default installation settings, provide an xml file with modified values as input.
To generate the xml file with default values, open a command prompt in the directory where
the installation program is located and perform the following command:

>MilestoneXProtectSmart Client.exe --generateargsfile=[path]

Open the generated arguments.xml file, using for example Windows Notepad, and perform
any changes needed. Then, to run silent installation using these modified values, perform the
following command in the same directory.

>MilestoneXProtectSmart Client.exe --arguments=args.xml --quiet

Install Milestone Mobile server

All XProtect system components, including the Milestone Mobile server, are available for separate
download and installation from the management server's download web page (controlled by XProtect
Download Manager):

1. Onthe management server, go to the Management server's download web page from
Windows' Start menu, select Programs, Milestone, Administrative Installation Page.

2. Select the Milestone Mobile server installer. Save the installer somewhere appropriate and run
it from here or run it directly from the web page.

3. Follow the instructions on the screen to install.

Once you have installed the Milestone Mobile server, you can use Milestone Mobile client and
XProtect Web Client with your system. To reduce the overall use of system resources on the computer
running the management server, install the Milestone Mobile server on a separate computer. For more
information about how to do this, see the Milestone Mobile server manual, available on the Milestone
website.

For more information about XProtect Download Manager, see Download Manager/download web
page (on page 40).

Download Manager/download web page

The management server has a built-in web page. This web page enables administrators and end
users to download and install required XProtect system components from any location, locally or
remotely.
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The web page is capable of displaying two sets of content, both in a language version that by default
matches the language of the system installation:

1 One web page is targeted at administrators, enabling them to download and install key
system components. Most often the web page is automatically loaded at the end of the
management server installation and the default content is displayed. On the management
server, you can access the web page from Windows' Start menu, select Programs >
Milestone > Administrative Installation Page. Otherwise you can enter the URL:

http://[[management server address]:[port]/installation/admin/

[management server address] is the IP address or host name of the management server, and
[port] is the port number which you have configured IS to use on the management server. If
not accessing the web page on the management server itself, log in with an account which has
administrator rights on the management server.

1 One web page is targeted at end users, providing them access to client applications with
default configuration. On the management server, you can access the web page from
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Windows' Start menu, select Programs > Milestone > Public Installation Page. Otherwise
you can enter the URL:

http://[[management server address]:[port]/installation/

[management server address] is the IP address or host name of the management server, and
[port] is the port number which you have configured IIS to use on the management server.

The two web pages have some default content so you can use them straight away after installation. As
administrator however, by using the Download Manager, you can customize what should be displayed
on the web pages. You can also move components between the two versions of the web page. To

move a component, right-click it, and select the web page version you want to move the component to.

Even though you can control which components users can download and install in Download
Manager, you cannot use it as a users' rights management tool. Such rights are determined by roles
defined in the Management Client.

On the management server, you can access the XProtect Download Manager from Windows' Start
menu, select Programs > Milestone > XProtect Download Manager.

Download Manager's default configuration

The Download Manager has a default configuration. This ensures that your organization's users can
access standard components from the start.

The default configuration provides you a default setup with access to downloading extra or optional
components. Usually you access the web page from the management server computer, but you can
also access the web page from other computers.

Download Manager = o=

Select which features users can download from the surveilance server

=[] Default
=[] English
£ [¥]%Protect Smart Client Installer
£ [¥] 2014 (B4 bi)
.~ [@4l Languages
[ 2014 (32 bid
* [7] &l Langusges

- [7] Arabic

- [¥] Bragiian

- [¥] Bulgarian

7] Ceech

7] Danish

-] Dutch

{7 Finnish

#+[7] French

=[] German

7] Hebrew

+[7] Hindi

/7] Hungarian

7] iahan

=[] Japaness

=[] Korean

+[7] Norwegian

++[7] Polish

/7] Russian

+[7] Simplified Chinese

7] Slovak

(7] Spanish

(7] Swedish

7] Thai

-] Traditional Chinese

m

-[F] Turkish
=[] Adrministration
=-¥] English
=[] Recording Server Installer -

I Remove features. H Apply H 1.9 H Cancel I

1 The first level: Refers to your XProtect product.
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1 The second level: Refers to the two targeted versions of the web page. Default refers to the
web page version viewed by end users. Administration refers to the web page version viewed
by system administrators.

1 The third level: Refers to the languages in which the web page is available.
1 The fourth level: Refers to the components which are - or can be made - available to users.

1 The fifth level: Refers to particular versions of each component, which are - or can be made -
available to users.

1 The sixth level: Refers to the language versions of the components which are - or can be
made - available to users.

The fact that only standard components are initially available - and only in the same language version
as the system itself - helps reduce installation time and save space on the server. There is no need to
have a component or language version available on the server if nobody uses it.

You can make more components or languages available as required and you can hide or remove
unwanted components or languages.

Download Manager's standard installers (user)

By default, the following components are available for separate installation from the management
server's download web page targeted at users (controlled by the Download Manager):

1 Recording servers, including failover recording servers. Failover recording servers are initially
downloaded and installed as recording servers, during the installation process you specify that
you want a failover recording server.

Management Client
XProtect Smart Client
Event server, used in connection with map functionality

Log server, used for providing the necessary functionality for logging system information

= =4 =4 -4 -2

Service channel, enables automatic and transparent configuration communication between
servers and clients

I Axis One-click Connection Component - only available here
1 Milestone Mobile server - only available here

1 More options may be available in your organization.

For installation of device packs, see Device pack installer - must be downloaded (on page 45).

Add/publish Download Manager installer components

You must complete two procedures to make non-standard components and new versions available on
the management server's download page.

First you add new and/or non-standard components to the Download Manager. Then you use it to
fine-tune which components should be available in the various language versions of the web page.
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If the Download Manager is open, close it before installing new components.
Adding new/non-standard files to the Download Manager:

1. On the computer where you downloaded the component(s), go to Window's Start, enter a
Command Prompt

2. Inthe Command Prompt, execute the name of the file (.exe) with:[space]--ss_registration
Example: RecordingServer_setup_x64.exe --ss_registration
The file is now added to the Download Manager, but not installed on the current computer.

To get an overview of installer commands, in the Command Prompt, type [space]--help and the
following window appears:

Command Ene option reference o
Installer2.0
This setup package accepts following command line switches:
—arguments= <filename> - Sets the argument file In quiet mode
-language=<lang> - Sets the languape for the installer and product. e.g. “en-US"
—partner_|d=<id> - Sets the partner ID, Used mostly for the Download Manager
—dm_sd=<id> - Sets the 1D for the Intemet Download Manager
—quist - Installs the software in guiet mode
~help - Shows this message
~-msilog - Enables extended msi bogging
~Jogpath=<filepath> - Sets the path to the log file
—acceptstatistics=<0/1> - Enables the Customer Expenence Improvement Program
-generateargsfile= <path> - Generates a file with the default arguments in the folder
—-showconsole - Enables console output In quiet mode
~license=<beensefile> - Sets the path to the hicense file
—licensetype=<type> - Sets the heense type
-55_regestration - Regusters this installer on the download page

When you have installed new components they are by default selected in the Download Manager and
are immediately available to users via the web page. You can always show or hide features on the
web page by selecting or clearing check boxes in the Download Manager's tree structure.

You can change the sequence in which components are displayed on the web page. In the Download
Manager's tree structure, drag component items and drop them at the required position.

Hide/remove Download Manager installer components
You have three options:

1 Hide components from the web page by clearing check boxes in the Download Manager's
tree structure. The components are still installed on the management server, and by selecting
check boxes in the Download Manager's tree structure you can quickly make the components
available again.

1 Remove the installation of components on the management server. The components
disappear from the Download Manager, but installation files for the components are kept at
C:\Program Files (x86)\Milestone\XProtect Download Manager, so you can re-install them later
if required.

1. Inthe Download Manager, click Remove features.
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2. Inthe Remove Features window, select the feature(s) you want to remove.

T4 Rernowve Features EI@

Select which features pou would like to remove from the
zurveilance server.

5[ Log Server Installer
=] w1.3.0 64 bit

L] 40l Languages
=-[" Service Charnel Installer
=[] 7.0d (54 bit)

= D tobile Server Installer
=] 2.7c (B4 bit)

m

= --D_.t’-‘-.:-tis Orne-Click Connection Component
5] 214 (32 bit)

-

Cancel

3. Click OK and Yes.

1 Remove installation files for non-required features from the management server. This can
help save disk space on the server if you know that your organization is not going to use
certain features.

Device pack installer - must be downloaded

The device pack (containing device drivers) included in your original installation is not included on the
download website. So, if you need to reinstall the device pack or make the device pack installer
available, you must first add or publish the latest device pack installer to the Download Manager:

1. Getthe newest device pack from the download page on the Milestone website
http://www.milestonesys.com/downloads.

2. Add/publish it to the Download Manager by calling it with the --ss_registration command.

If you do not have a network connection, you can reinstall the entire recording server from the
Download Manager. The installation files for the recording server is placed locally on your computer
and in this way you automatically get a reinstall of the device pack.

Upgrade

About upgrade

This information is only relevant if you are upgrading a previous XProtect installation.
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Important: Your XProtect system no longer supports Microsoft Windows XP.

When you upgrade, all components, except the management server database, are automatically
removed and replaced. This includes the drivers of your device pack.

The management server database contains the entire system configuration (recording server
configurations, camera configurations, rules, and so on). As long as you do not remove the
management server database, no reconfiguration of your system configuration is needed, even if you
may want to configure some of the new features in the new version.

Backward compatibility with recording servers from versions older than this current version is limited.
You can still access recordings on such older recording servers, but to be able to change their
configuration, they must be of the same version as this current one. Therefore, it is highly
recommended to upgrade all recording servers in your system.

When you do an upgrade including your recording servers, you are asked whether you want to update
or keep your video device drivers. If you choose to update, it might take a few minutes for your
hardware devices to make contact with the new video device drivers after restarting your system. This
is due to several internal checks being performed on the newly installed drivers.

Upgrade prerequisites

1 Have your temporary license (.lic) file ready. The license file changes when your SLC
changes, so you may have received a new license file when you purchased the new version.
When you install the management server, the wizard asks you to specify the location of your
license (.lic) file, which the system verifies before you can continue.

If you do not have your license file, contact your XProtect product vendor.

1 Have your new product version ready. If you have not purchased the software on a DVD,
you can download it from http://www.milestonesys.com/downloads.

1 The management server stores your system's configuration in a database. The system
configuration database can be stored in two different ways:

1. Ina SQL Server Express Edition database on the management server itself
2. In a database on an existing SQL Server on your network.

If using 2), you must have Administrator rights on the SQL Server whenever you want to
create, move or upgrade the management server's system configuration database on the SQL
Server. Once you are done creating, moving or updating, being the database owner of the
management server's system configuration database on the SQL Server is sufficient.

When you are ready to start the upgrade, follow the procedures in Install the system (on page 30).

Alternative upgrade for workgroup

If you do not use a domain setup, but a workgroup setup, you must do the following when you
upgrade:

1. On the recording server, create a local Windows user.
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2. From the Windows Control Panel, find the Milestone XProtect Data Collector service.
Right-click it, select Properties, and select the Log on tab. Set the Data Collector service to
run as the local windows user you just created on the recording server.

3. On the management server, create the same local Windows user (with the same user name
and password).

4. In the Management Client, add this local Windows user to the Administrator's group.

For installing with workgroups, see Installation for workgroups (on page 34).
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First time use

Best practices

Protect recording databases from corruption

You can select which action to take if a camera database becomes corrupted. The actions include
several database repair options. While it is good to have such options, Milestone recommends that
you take steps to ensure that your camera databases do not become corrupted.

Hard disk failure: protect your drives

Hard disk drives are mechanical devices and are vulnerable to external factors. The following are
examples of external factors which may damage hard disk drives and lead to corrupt camera
databases:

Vibration (make sure the surveillance system server and its surroundings are stable)
Strong heat (make sure the server has adequate ventilation)

Strong magnetic fields (avoid)

Power outages (make sure you use an Uninterruptible Power Supply (UPS))

Static electricity (make sure you ground yourself if you are going to handle a hard disk drive).

= =4 =4 -4 -4 -2

Fire, water, etc. (avoid)

Windows Task Manager: be careful when you end processes

When you work in Windows Task Manager, be careful not to end any processes which affect the
surveillance system. If you end an application or system service by clicking End Process in the
Windows Task Manager, the process is not be given the chance to save its state or data before it is
terminated. This may lead to corrupt camera databases.

Windows Task Manager typically displays a warning if you attempt to end a process. Unless you are
absolutely sure that ending the process is not going to affect the surveillance system, click No when
the warning message asks you if you really want to terminate the process.

Power outages: use a UPS

The single-most common reason for corrupt databases is the recording server being shut down
abruptly, without files being saved and without the operating system being closed down properly. This
may happen due to power outages, due to somebody accidentally pulling out the server's power cable,
or similar.

www.milestonesys.com 48 First time use



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

The best way of protecting your recording servers from being shut down abruptly is to equip each of
your recording servers with a UPS (Uninterruptible Power Supply).

The UPS works as a battery-driven secondary power source, providing the necessary power for
saving open files and safely powering down your system in the event of power irregularities. UPSs
vary in sophistication, but many UPSs include software for automatically saving open files, for alerting
system administrators, etc.

Selecting the right type of UPS for your organization's environment is an individual process. When you
assess your needs, however, bear in mind the amount of runtime you require the UPS to be able to
provide if the power fails. Saving open files and shutting down an operating system properly may take
several minutes.

About daylight saving time

Daylight saving time (DST) is the practice of advancing clocks in order for evenings to have more
daylight and mornings to have less. The use of DST varies between countries/regions.

When you work with a surveillance system, which is inherently time-sensitive, it is important that you
know how the system handles DST.

Spring: Switch from Standard Time to DST

The change from standard time to DST is not much of an issue since you jump one hour forward.
Typically, the clock jumps forward from 02:00 standard time to 03:00 DST, and the day has 23 hours.
In that case, there is no data between 02:00 and 03:00 in the morning since that hour, for that day, did
not exist.

Fall: Switch from DST to Standard Time

When you switch from DST to standard time in the fall, you jump one hour back. Typically, the clock
jumps backward from 02:00 DST to 01:00 standard time, repeating that hour, and the day has 25
hours. In that case, you reach 01:59:59, then immediately revert back to 01:00:00. If the system did
not react, it would essentially re-record that hour, so the first instance of, for example, 01:30 would be
overwritten by the second instance of 01:30.

Because of this, your system forcefully archives the current video in the event that the system time
changes by more than five minutes. The first instance of the 01:00 hour is not viewable directly from
clients. However, the data is recorded and safe, and it can be browsed using the XProtect Smart
Client by opening the archived database directly.

About time servers

Once your system receives images, they are instantly time-stamped. Since cameras are separate
units which may have separate timing devices, camera time and your system time may not correspond
fully. This may occasionally lead to confusion. If your cameras support timestamps, Milestone
recommends that you auto-synchronize camera and system time through a time server for consistent
synchronization.

For information about how to configure a time server, search www.microsoft.com
http://www.microsoft.com/ for time server, time service, or similar.
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Management Client overview

About login authorization

If you encounter a second dialog during login, you need additional login authorization to get access to
the Management Client.

When you log into the Management Client, you may be asked to for additional authorization of your

login. You need a person who has the rights to authorize you to enter their credentials in the
authorization login window.

If you do not know who can authorize you, ask your system administrator.

Management Client window overview

The Management Client window is divided into panes. The number of panes and layout depend on
your:

1 system configuration
1 task

 available functions.

Below are some examples of typical layouts:

1 When you work with recording servers and devices:
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1 When you work with rules, time and notification profiles, users, roles:

Administrator's Manual

ki

ECEE
U

T T

www.milestonesys.com

gl iiinEnnnaRnEEAL AR nEnEnee e

51

First time use



Milestone XProtect® Advanced Administrator's Manual
VMS 2014

Panes overview

The illustration outlines a typical window layout. You can customize the layout so it may look different
on your computer.

Site Navigation pane: This is your main navigation element in the Management Client. It reflects the
name, settings and configurations of the site that you have logged in to. The site name is visible at the
top of the pane. The features are grouped into categories that reflect the functionality of the software.

Federated Site Hierarchy pane: This is your navigation element that displays Milestone Federated
Architecture sites and their parent/child links.

The parent server that you are logged in to, your home site, is always at the top. If you adopt its point
of view, you can view all its linked children and downwards in the parent/child hierarchy.

Overview pane: Provides an overview of the element you have selected in the Site Navigation pane,
for example a detailed list. When you select an element in the Overview pane, it typically displays the
properties in the Properties pane. When you right-click elements in the Overview pane you get
access to the management features.

Properties pane: Displays properties of the element selected in the Overview pane. Often, properties
are displayed across a number of tabs:

AT Setlings | © Info | %2 Stocage
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Preview pane: The Preview pane appears when you work with recording servers and devices. It
shows preview images from the selected cameras or displays information about the state of the
device. The example shows a camera preview image with information about the resolution and data
rate of the camera's live stream:

Live: 6402480 35kE

Camera S

By default, the information shown with the camera preview images concerns live streams. This is
displayed in green text above the preview. If you want recording stream information instead (red text),
select View > Show Recording Streams in the menu.

Performance can be affected if the Preview pane displays preview images from many cameras at a
high frame rate. To control the number of preview images, and their frame rate, select Options >
General in the menu.

Menu overview

e Edt Yiew | Action | Tooks Her

% Add New Device Group... CTRL+N

%8 Edk Device Group Members. ..

&R Delete Device Group DELETE
Rename Device Group F2

B Go To Hardware...

/o Refresh FS

File menu

You can save changes to the configuration and exit the application. You can also back up your
configuration, see About backing up and restoring your system configuration (on page 332).

Edit menu

You can undo changes.
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View menu

Reset Application Layout

Preview Window

Show Recording Streams

Federated Site Hierarchy

Site Navigation

Action menu

Administrator's Manual

Reset the layout of the different panes in the Management Client to
their default settings.

Toggle the Preview pane on and off when working with recording
servers and devices.

By default, the information shown with preview images in the
Preview pane concerns live streams of the cameras. If you want
information about recording streams instead, select Show
Recording Streams.

By default, the Federated Site Hierarchy pane is enabled.

By default, the Site Navigation pane is enabled.

The content of the Action menu differs depending on the element you have selected in the Site
Navigation pane. The actions you can choose from are the same as when you right-click the element.
The elements are described in Management Client elements (on page 56).
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Refresh

Tools menu

Registered Services

Enterprise Servers

Effective Roles

Options

Help menu

Administrator's Manual

Is always available and reloads the requested information from the
management server.

Manage registered services.
See About the service channel (on page 348).

Add XProtect Enterprise servers to your system and manage the
integration of the added servers.
See About XProtect Enterprise servers (on page 327).

You can also use the feature to migrate from an XProtect Enterprise
system to XProtect Corporate. This is described in a separate
document.

Only supported if your system:

- runs XProtect Corporate

- uses IPv4

- works with XProtect Enterprise servers running XProtect
Enterprise version 6.0 and up

View all roles of a selected user or group.
Only relevant if you run XProtect Corporate.

Opens the Options dialog box, which lets you define and edit global
system settings.

Only relevant if you run XProtect Corporate.

You can access the help system and information about the version of the Management Client.
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Management Client elements

Basics

License information

You can keep track of the licenses on this site and on all other sites licensed on the same software
license code (SLC).

Installed Products

Lists all installed products on this site:
1 Product version.
1 Software license code (SLC).
1 Expiry date of your SLC. Typically unlimited.
1 Expiry date of your software upgrade plan (SUP).

(] 1nstalled Products

)

Product Version Software License Code | Expiry Date Software Upgrade Plan Expiry
XProtect Corporate 2014 C70-A00C-XxXXX Unlimited 1722014
Milestone XProtect Smart Wall 9A0-A09D-XxxXX Unlimited
Milestone XProtect Access Control Module  C70-A00C-XXXX N/A
Licensed to:
Milestone Systems A/S
Contact details:

Banemarksvej 50C
2605 Brondby
Greater Copenhagen Area Denmark

Log on to edit details Link

Contact details on the owner of the SLC

1 Contact details of the customer (license owner) have been added during software registration.
Click Link to edit the license owner information.
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License Information

License Information

e Total-All s
Hardware Device 100 26 1 0 0 0

Mil I Camera 10 3 0

Door 4 0 0 0 0 0

Activate License

| Activate License... | - |

All Sites

| License Overview... |

Information refreshed Thursday, March 27, 2014 10:11:24 AM @

Example only. Numbers and dates may be different on your system

1 Unlicensed hardware devices do not send data to the surveillance system, so the hardware
device's cameras cannot be used for monitoring and recording.

1 Hardware devices that you add after all available licenses are used, are listed as missing so
they cannot be used for monitoring and recording.

1 Devices connected to unlicensed hardware devices are identified by an exclamation mark in
the Management Client. Note that the exclamation mark is used for other purposes.

Total - All Sites lists the status of licenses on all sites obtained with this SLC:
1 License type - hardware device:

o The total number of obtained and activated hardware device licenses on all sites using this
SLC.

o If you run Milestone Interconnect, the total number of obtained and activated Milestone
Interconnect camera licenses on all sites using this SLC.

1 License type - doors:

o If you run XProtect Access Control Module, the total number of obtained and activated
door licenses on all sites using this SLC. Door licenses are only listed if you have
purchased XProtect Access Control Module. You can also see license details for each
door under the Access Control node.

Current Site:
9 The number of licenses on the current site:

o The number of activated licenses and temporary (not activated) licenses.
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o If you need additional licenses for new hardware devices, add the number of missing
licenses to the number of expired licenses to get the total number of required licenses.

1 Expiry date of the next hardware device license appears in red below the table (if applicable).
The date is counted from the day you added the hardware device.

1 Drop-down list box to activate licenses online or offline.

9 Button to access a license overview for all sites licensed via this SLC.

Devices which require a license

You need licenses for the number of hardware devices, for example video encoders or cameras, that
you you want to run on the system. One hardware device license enables you to run as many camera,
speaker, microphone, input, output and metadata devices that the hardware device consists of. It also
enables you to run the hardware device multiple times on one site or multiple times on multiple sites.

You need a camera license for each enabled interconnected camera in a Milestone Interconnect
setup.

If you purchase XProtect Access Control Module, you need a license for each door you want to
configure for access control.

You can always get more licenses as your surveillance system grows, see Get additional licenses (on
page 60).

View license overview

You can access a license overview that lists activated, temporary, expired and missing licenses for all
sites licensed via this SLC.

9 Click License Overview.

If the site is not a federated site or the connection is down, you can only view the number of activated
licenses. N/A appears for temporary, expired, and missing licenses.

Activate licenses online

Activate your licenses online if the computer that runs the Management Client has Internet access.
1. Onthe License Information node, select Activate License and then Active License Online.
2. The Activate Online dialog box opens.

o If you are an existing user, enter your user name and password to log into the software
registration system.

o If you are a new user, click the Create new user link to set up a new user account and
then follow the registration procedure. If you have not yet registered your Software License
Code (SLC), you must do so.

3. If you select Save password, the password is saved on the computer.
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4. Click Next and follow the wizard's remaining steps to activate your licenses. Use the exact
same user name under which you registered the SLC.

5. When you have activated your licenses, you see a confirmation.

6. Click Finish to end the activation.

If you receive an error message during online activation, follow the instructions on the screen to solve
the issue.

If you have followed the instructions and still cannot access online activation, contact Milestone
Support, who investigates the issue for you.

Activate licenses offline

If the computer that runs the Management Client does not have Internet access, you can activate
licenses offline. First you export the license request and provide it to Milestone, who then actives the
licenses. When you receive the activated licenses, you import them into your system:

1. To export a file with your currently added cameras, click Activate License, and select
Activate License Offline > Export License For Activation.

Specify a file name and a location for the license request (.Irg) file.
Open an Internet browser and go to the Milestone website http://www.milestonesys.com.

Locate the software registration page.

o  w D

If you have used the software registration system before, log in with your username and
password. Otherwise, click New to the System? to create a new user account and add the
SLC to the account.

a) Select the SLC under Active SLCs.

b) Inthe menu for SLC properties, use the Upload License Request function to upload the
generated LRQ file.

c) An emalil is sent to you.

6. When you have received the updated license file (.lic), save it at a location accessible from the
Management Client.

7. In the Management Client, click License Information.
8. Click Activate License Offline > Import Activated License, and select the .lic file to import it.

9. Click Finish to end the activation process.

Activate licenses after grace period

If you do not activate an expired license (hardware, Milestone Interconnect system, or door license)
within the grace period, the device becomes unavailable and cannot be used in the surveillance
system.
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1 Configuration, added cameras, and other settings are not removed from the Management
Client.

1 The license is not deleted from the system configuration, so to enable the unavailable devices
again, activate the license online or offline as usual.

Get additional licenses

If you want to add or if you have already added more hardware devices, Milestone Interconnect
systems, or doors than you currently have licenses for, you must buy additional licenses to enable the
devices to send data to your system.

1. To get additional licenses for your system, contact your XProtect product reseller.

2. When you have received an updated license file (.lic) with the new licenses, you must activate
your licenses.

Licenses and hardware device replacement

You can replace a hardware device, such as camera, licensed in your system with a new device, and
have the new device activated and licensed instead.

If you remove a hardware device from a recording server, you free a license.

If you, for example, replace a camera with a similar camera (manufacturer, brand, and model), and
give the new camera the same IP address, you maintain full access to all the camera's databases. In
this case, you move the network cable from the old camera to the new one without changing any
settings in the Management Client, and then activate the license.

If you replace a hardware device with a different model, you must use the Replace Hardware wizard
(see Replace hardware (on page 340)) to map all relevant databases of cameras, microphones,
inputs, outputs, and settings. When done, remember to activate the license.

Over time, there is a limit to the number of hardware devices you can replace depending on the
number of hardware devices in your system. You receive a message from the system to contact
Support, when you try to active a license online that exceeds the maximum number of allowed
replacements.

Site information

You can add additional information to a site for an easier identification of each site, for example, in a
large Milestone Federated Architecture setup. Apart from the site name, you can describe:

 Address/location
1 Administrator(s)

1 Additional information

Update site information

To update site information:
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Select Edit.
Select a tag.

Enter information in the Value field.

A woNop

Click OK.

Servers and hardware

Recording servers

About recording servers

You use recording servers for recording video feeds, and for communicating with cameras and other
devices. A surveillance system typically contains several recording servers, even though you only
need a single recording server for the system to work.

Recording servers on your system, that is computers with the recording server software installed, and
configured to communicate with a management server, are listed in the Overview pane when you
expand the Servers folder and then select Recording Servers.

Site Navigation /3 [Recording Server
= B Kerver = “*ﬂd“ﬂt’f
= {1} Basics + H | My Recoiding Server |

i Getling Started
L__' License Infoimatian
=il Servers

iV Recording Seivers
% ] Failcover Server:

= *:5‘ Devices
T Cameias

Backward compatibility with recording servers from product versions older than this current version is
limited. You can still access recordings on such older recording servers, but if you want to change their
configuration, make sure they match the current version. Milestone recommends that you upgrade all
recording servers in your system to the same version as your management server.

Important: When the Recording Server service is running, it is very important that Windows Explorer
or other programs do not access Media Database files or folders associated with your system setup. If
they do, the recording server might not be able to rename or move relevant media files, which might
bring the recording server to a halt. If this situation has already occurred, stop the Recording Server
service, close the program accessing the relevant media file(s) or folder(s)n, and restart the Recording
Server service.
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